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Introduction

Type of e-mail users.

1.Home users: need Internet, e-mail, and 
newsgroup.

2.Business users: need more e-mail functionality 
and 

tight integration between tools for information 

management and collaboration.
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Introduction (cont…..)

Outlook Express: 
• Suitable for Home users.
• Included with Microsoft Internet Explorer.
• Free with all Microsoft Operating Systems.
• Built on open Internet standards.
• Used with SMTP, POP3, IMAP
• Provides full support for LDAP, MHTML, 

HTML, S/MIME, and NNTP
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Introduction (cont…..)

Outlook:
• Suitable for Business users.
• Powerful Inbox rules to filter and organize e-

mails.
• Multiple e-mail accounts.
• Personal and Group Calendars.
• Contacts and Tasks.
• Designed for use with Internet (SMTP, POP3, 

and IMAP4), Exchange or any other 
communication system that support MAPI, 
including voice mail.
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Introduction (cont…..)

• Supports LDAP, MHTML, HTML, NNTP, 
MIME, and S/MIME, vCalendar, vCard, 
iCalendar.

• Supports easy migration from Microsoft Mail, 
Microsoft Schedule+ 1.0, Microsoft 
Schedule+ 7.0, Lotus Organizer, NetManage 
ECCO, Starfish SideKick, Symantec AC.

• Support for Synchronization with all leading 
Personal Digital Assistants (PDAs) such as 3 
Com Pam Pilot.   
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Introduction (continue…..)

Outlook with Exchange Server:
• Workgroup information sharing and 

workflow communications.
• Group Scheduling.
• Public Folders and Forms.
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Understanding the basics (cont…..)

Information required to configure Outlook:
• Type of account (Exchange Server, 

POP3, IMAP, HTTP).
• Name of incoming and outgoing 

servers.
• User name.
• User e-mail address.
• User password.
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Understanding the basics (cont…..)

How to connect your e-mail server:

1. Over Phone lines
2. Through LAN
3. Using another dialing program
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Understanding the basics (cont…..)

Outlook e-mail Profiles contains :
1. What e-mail account 

information to use.
• User name
• Display name
• E-mail server name
• Account password

2. Where the data is delivered 
and stored.
• On e-mail server
• In a .pst file on your computer
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Understanding the basics (e-mail Profile)

Scenario to use multiple e-mail 
profiles:
1. You want to keep your 

work data separate from 
your personal data.

2. You are using a shared 
computer. 

3. You have multiple 
Exchange Server e-mail 
accounts. 
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Setting e-mail account in Outlook
Add an e-mail account:

1. On the “Tools” menu, click “E-mail 
Accounts”.

2. Select “Add a new e-mail account”, 
and then click “Next”

3. Select the e-mail server type 
(Microsoft Exchange Server, POP3, 
IMAP, HTTP, additional server 
type) used for your account, and 
then click “Next”.

4. In the appropriate boxes, type the 
required information, and then 
click “Next”. 
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Managing Personal Folder files (.pst) 

Determine whether the default 
delivery location is a .pst file:

• On the Tools menu, click 
E-mail Accounts. 

• Click View or change 
existing e-mail accounts, 
and then click Next. 

• Under Deliver new e-mail 
to the following location, 
verify the default delivery 
location that is listed. 
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Managing Personal Folder files (.pst) (cont…) 

Creating a new data file (.pst)
1. On the “File” menu, point to 

“New”, and then click “Outlook 
Data File”.

2. Select “Office Outlook Personal 
Folder File (.pst)”, and then 
click “OK”

3. In the “File name” box, type a 
name for the file, select the 
location, and then click “OK”.

4. In the “Name” box, type a 
display name for the .pst folder, 
and then click “OK”.  
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Managing Personal Folder files (.pst) (cont…)

Changing Password of .pst file:
1. Click “Data File Management”

in “File” menu.
2. Select your .pst file and click 

“Settings”.
3. Change your Password, and 

click “OK”
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Inbox Management 

• Use colors to make specific messages stand out. 

• Easily locate messages by changing the way they are 
arranged.

• Use flags to set your own priorities for how and when to 
follow up on messages. 

• Organize messages into actual groups and virtual groups 
by using folders and Search Folders. 

• Get easy access to the folders you use most often by 
adding them to the Favorite Folders pane. 
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Inbox Management (cont….)

Color code with automatic 
formatting:

Whether you keep a lot of e-mail 
around or only a few messages, you 
can use colors to help clarify what's 
there.

You can use the Automatic 
Formatting feature to instantly 
organize your e-mail with color.

See messages from your 
boss in one color and 
messages from your 
friend in another.
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Inbox Management (cont….)

Color code messages:

Use Automatic Formatting to make 
certain messages stand out with 
color.

Even if you have thousands of 
messages in your Inbox, the green 
ones will catch your attention.
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Inbox Management (cont….)

Use Organize for color coding: 

Once you select a message and click 
the Organize command on the 
Tools menu, you're just a few quick 
steps away from color-coded 
messages.

To color code messages, 
use the Organize pane. 

1. Click Using Colors.

2. Set up the rule for color coding.

3. Click Apply Color.
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Inbox Management (cont….)

Find it fast with arrangements

You may be able to spot the 
message you're looking for more 
quickly by changing the way 
messages are arranged.
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Inbox Management (cont….)

By default, Outlook shows 
messages grouped and sorted by 
date.

1. The type of arrangement.

2. How messages are ordered. Here 
the newest messages are on top.

3. Outlook displays only relevant 
date information.

4. To see the full date, position the 
pointer over the displayed date.

In messages grouped by 
date, one thing you’ll 
always be able to see is 
the sender’s name.
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Inbox Management (cont….)

Quickly change arrangements:

You can also arrange messages 
other ways: by size, by who they're 
from, or by subject (to name just a 
few). 

To quickly change from one 
arrangement to another, you would 
click Arranged By and select the 
choice that suits you.

The Arranged By
shortcut menu
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Inbox Management (cont….)

Arrange by conversation topic:

When you arrange messages by 
conversation topic, only unread 
messages are displayed.

At first, you'll see only the bits of the 
conversation that you haven't yet read.

To see all the messages, click the arrow 
next to the conversation title (circled in 
the picture).
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Inbox Management (cont….)

Use flags to follow up:

You can use flags to prioritize your 
messages and follow up.
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Inbox Management (cont….)

Flag it!

You can flag messages right from 
your Inbox.

1. The Flag Status column. Right-
click here to add a flag. 

2. You have six flag colors to choose 
from. The flags aren’t labeled, so 
you decide what significance to 
assign a particular color. 
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Inbox Management (cont….)

Flag it!

You can flag messages right from 
your Inbox.

3. When you've followed up, use the 
Flag Complete command to 
change the flag status. 

4. Use Add Reminder to set a date 
and time for a reminder.
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Inbox Management (cont….)

Use folders:

Folders can help you sort your 
messages into intuitive groups.

Folders can reflect your personal 
needs and interests.
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Inbox Management (cont….)

How to create a folder in your Inbox

• Right-click Inbox.

• Click New Folder.

Then, you would type the name of 
the new folder and click OK.
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Inbox Management (cont….)

Creating Rules:
1. Right click the message.
2. Click “Create Rule..”
3. Create rule according to 

your need, and then click 
“OK”.
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Junk e-mail Management

Junk e-mail, often called "spam," can 
be bothersome and even offensive.

Outlook 2003 includes powerful tools 
that will help you slice the spam and 
recapture your Inbox.
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Junk e-mail Management (cont….)

How the filter works:

Outlook treats a message as junk 
because of several factors, including 
the time it was sent, the sender, the 
names on its To line, and its 
content.
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Junk e-mail Management (cont…)

Where junk messages go:

If the filter deems a message to be 
junk, the message is moved to the 
Junk E-mail folder.

The Junk E-mail folder 
in the Navigation Pane
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Junk e-mail Management (cont…..)

Controlling  the Junk E-mail filter:

1. These options adjust the level of 
protection. Your choice here 
determines the filtering applied 
to incoming messages.

2. Use these tabs to view and 
modify the Safe Senders, Safe 
Recipients, and Blocked Senders 
lists.

The Junk E-mail 
Options dialog box
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Junk e-mail Management (cont….)

Safe or Blocked? You decide with 
lists:

Messages from or to people on your 
Safe lists are always allowed into 
your Inbox.

Messages from people on your 
Blocked Senders List are banished to 
the Junk E-mail folder.
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Junk e-mail Management (cont….)

Safe and Block lists:

Your Safe and Blocked lists can evolve as 
you receive e-mail. 

You can add names to these lists directly 
from messages in your Inbox.

1. Right-click the message.

2. Click Junk E-mail.

3. Choose from the commands on 
the shortcut menu.
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Junk e-mail Management (cont….)

If a message is addressed to more 
than one person and you click Add 
Recipient to Safe Recipients 
List…

…you'll see a dialog box similar to 
this one.

Use it to choose which addresses 
to add to your Safe lists.
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Junk e-mail Management (cont…)

Use a domain name in your Safe or 
Blocked lists:

A domain name in a Safe list 
allows all messages with that 
domain to pass directly to your 
Inbox.

The domain name is 
the part of an e-mail 
address after the @ 
sign.
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E-mail Security and Privacy Tips

1. Create Windows user accounts.
2. Use Microsoft Windows logon password.
3. Create Multiple Outlook profile. 
4. Set a Password on your Personal Folder file 

(.pst).
5. Always use strong password.
6. Keep changing your e-mail account password 

periodically.
7. Configure your Junk E-mail filter setting according 

to your need.  
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E-mail Security and Privacy Tips (cont…)

8. Keep your Junk e-mail filter updated.
9. Block images in HTML messages. By default 

Outlook is set to block automatic picture 
downloads. (Tools-Option-Security-Change 
Automatic Download Settings).

10.Turn off automatic processing of meeting 
requests and read and delivery receipts.

11. Be cautious about posting your e-mail address 
on public web sites.

12.Don’t reply to spam.
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Thanks.
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